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4 Quick Start

This guide will run you through the basics of setting up a data source and creating
charts using Chart Designer. This guide assumes you are running locally on a
Windows NT/2000/XP machine.

If you're not running on a Windows machine you can still use this guide, however, you
won't be able to use the sample Access database. There is a text file that you can use
instead to create the same chart.

4.1 Step 1: Start Chart Designer

To start Chart Designer you will first need to start EspressManager. To start
EspressManager, execute the EspressManager batch file that is in the root directory
of your installation. For Windows installations, you can also start EspressManager
from the Start menu if you selected to create shortcuts when installing the software.

Once EspressManager is running, you can launch Chart Designer by executing the
Designer batch file in the root directory of your installation. For Windows installations,
you can also start Chart Designer from the Start menu if you selected to create
shortcuts when installing the software. When Chart Designer is started, a login
window will appear prompting you for a user name and a password. Enter "guest” as
the user name, and leave the password field blank.

& = E3

Login

EUser Mame : |guest

|Password :

Stark EspressChark |

Click 'Start EspressChart' and Chart Designer will open as a new window.

$B Chart Designer
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4.2 Step 2: Start new chart & data
source registry setup

To start a new chart, select 'New' from the File menu. A dialog will appear asking if
you would like to create a new data source registry, or use an existing one. A data
registry is an XML file that stores database connections, queries, and file locations for
text and XML sources. Select 'Start a new data registry' and click 'Next'.

& Select Data Registry
Please select an option

* Start a new data registry

{~ Open an existing data regiskry

<< Back | Cancel | Mext =32 |

You will then be prompted to enter a name for your data registry. You can name it
anything you want, and an XML file of the same name will be created in the
DataRegistry directory. After you have specified a name, the Data Source Manager
will open. Since this is a new registry there are no nodes under the data source types
in the window.

& New Data Registry E

Name : ||Mwwr00thspressCharthataRegislrwStanGuide

Browse. .. | 0K | Caneel |

& pata Source Manager : E:/Inetpu... [H[=] E3

EDIT |
#MLFiles
B TTFiles p—— |
i ClassFiles

& E1Bs

ADD |
REMEYE |
BACK |

CANCEL |
ERT |

4.3 Step 3: Data sources setup

The first data source to set up is a database. EspressChart comes with two sample
databases. One is HSQL which is a pure Java application database. The other is a
MS Access Database. Both contain the same data.

To set up the HSQL data source, you will need to modify EspressManager so that it
picks up the classes for the JDBC driver when it starts. (This procedure will be the
same for any JDBC data source). To modify the EspressManager's classpath you will
need to modify the EspressManager.bat or .sh file that was created by the installer.

EspressChart User's Guide



Chapter 4 Quick Start 35

Open the EspressManager .bat or .sh file in a text editor or at the command line, and
modify the "-classpath" argument to point to the hsqgldb.jar file which is under the
help/examples/DataSources/database directory of your EspressChart installation. Be
sure to put the path to the .jar file in the argument as well. In the .bat file separate files
in the classpath with a semi-colon, and in the .sh file use a colon.

*Note - If you're running EspressManager and/or Chart Designer, you'll want to shut
them down before modifying the .bat or .sh files, as you'll need to re-start them in
order for the changes to take effect.

The modified EspressManager.bat should look like this:

set JAVA EXECUTABLE=D:\j2sdkl.4.1_02\bin\java.exe

set PATH=%PATH%; -\lib\

"%JAVA EXECUTABLE%" -Xmx32M -classpath " .\lib\EspressManager _jar;
\lib\FlashExport_jar; \lib\ExportLib_jar; .\lib\jaxp_jar;
\lib\parser._jar; \1ib\SVGExport.jar;
\help\examples\DataSources\database\hsqgldb.jar;.;"
quadbase.common.server _Server -monitor:ON -log -DBBuffer:1 —
DBCleanAll:600

The modified EspressManager.sh should look like this:

JAVA_EXECUTABLE=/System/Library/Frameworks/JavaVM. framework/
Versions/1.3.1/Home/bin/java

export JAVA EXECUTABLE PATH=$PATH:./lib

export PATH

exec $JAVA_EXECUTABLE -Xmx32M -classpath "./lib/EspressManager .jar:
_/lib/FlashExport_jar:_/lib/ExportLib_jar_./lib/jaxp.jar:
_/lib/parser_jar: _/1ib/SVGExport.jar:
-/help/examples/DataSources/database/hsgldb.jar:._:"
quadbase.common.server _Server -monitor:ON -log -DBBuffer:0 -
DBCleanAll:600

Once you have finished the modifications, save the changes you've made to the .bat
or .sh file, and re-start EspressManager.

*Note - If you're running on Mac OS X and you elected to create aliases when
installing, you will need to modify the espressmanager.app package to add the
hsgldb.jar to the classpath. To do this right-click (CTRL+Click) on the
espressmanager.app and select 'Show Package Contents' from the pop-up menu.
Then navigate to Contents/Resources where you wil see a file called
'MRJApp.Properties'. Open this file in a text editor and add the .jar file to the classpath
argument.

With the modified EspressManager running, re-start Chart Designer, and open your
data registry again. From the Data Source Manager, click on the "Databases" note in
the left-hand frame, and click the 'Add' button. A dialog will then appear prompting you
to enter the connection information for the new database. Enter "Woodview" as the
name of the Database, enter "jdbc:hsqgldb:help/examples/DataSources/database/
woodview" for the URL, and enter "org.hsgldb.jdbcDriver" as the driver. Click on both
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the 'Require Login' and 'Save Password' boxes. Then enter "sa" for the user name
and leave the password blank.

i Setup Database...

~Datak Information
Matne: Wioodvies
URL: implesDataSourcesidatabas et oocview
Driver: org heglch jdbcDriver

Uszer Mame: |sa

Password:

v Reguire Login V¥ Save Password

Test Connection |

~Default Option
¥ tuto Jain

ILInquaIified Table Matre LI

(91,4 | Cancel |

Leave the auto-join and table name properties alone, and click the 'Test Connection’
button to make sure you've entered the information correctly. Then click 'OK' to bring
back up the data source manager window, where there will be a new node under
"Databases" for Woodview.

If you're running on Windows, then you can use JDBC-ODBC bridge to connect to the
sample MS Access database that is included in the installation. Before setting up this
database as a data source in EspressChart, you must first set up the database as an
ODBC data source in your Windows environment. To do this, launch the ODBC Data
Source Administrator from the Windows control panel. Then add a users or system
DSN. Select Microsoft Access as the database driver, and specify the data source
name as "Woodview". Then click the 'Select' button under '‘Database’. Browse to the
Woodview.mdb  file  found in the EspressChart installation  under
help\examples\ DataSources\database. Select this file. You should now see a new
entry under the "System DSN" or "User DSN" tab called Woodview.

€10DBC Data Source Administrator HE
User DSH  System DSN I File DSM I Dnvelsl Tracingl Connection F'UUIingI About I

Swstem Data Sources:

M ame | Drriver |;| Add |
ajan SOL Server

boak1 Microzoft Excel Diiver [%.xls) Bemove |
Customers  Microsaoft Access Driver [* mdb)

Morthwind Microzoft Access Driver [*.mdb) Lonfigure... |
gbcustomers  Quadbase 5.0 32bit Driver

test Quadbase 5.0 32bit Driver

Testdata Microzoft Excel Diriver [*.xlz]
LA ERE Microsoft Access Driver [*.mdb)

An ODBC System data source stores information about how to connect ta
the indicated data provider. A Swstem data source iz visible to all users
oh this machine, including NT services.

Ok I Cancel Ll Help
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Once you have properly set up the DSN for Woodview, go back to the Data Source
Manager. Click on the "Databases" node in the left-hand frame, and click the 'Add’
button. A dialog will then appear prompting you to enter the connection information for
the new database. If you are using Sun's JVM (i.e. JRE 1.3 or similar) then the default
driver supplied in the dialog will work. Enter "WoodviewODBC" as the name of the
database, and enter "jdbc:odbc:Woodview" for the URL. Click on both the "Require
Login" and "Save Password" boxes. Then enter "admin" for both the user name and
password.

4 Setup Database...

~Datal Information

Mame: Winodview ODEC
LRL: iclbc: odbecwoodview
Drriver: sun jobc odbe JdbcOdbcDriver

Uzer hame: |admin

Pazsword: |[##%%%

IV Require Login [V Save Password
Test Connection |

[V auto Join

-Default Option:

IUnquaIified Table Marne LI

OK | Cancel |

Leave the auto-join and table nhame properties alone, and click the 'Test Connection’
button to make sure you've entered the information correctly. Then click 'OK' to bring
back up the data source manager window, where there will be a new node under
"Databases" for WoodviewODBC.

& Data Source Manager : D:/Espres... !E

E_B Databazes EDIT |
B vnodview
- 3 oo viesw ODEC CERY
XMLFiles |
Ei TXTFiles DD
ClazsFiles
€ Es

REMONVE

BACK

CAMCEL

TEXT

Jife

To add a text data source, click on the "TXTFiles" node in the left-hand frame of the
Data Source Manager and click 'Add'. A dialog will appear prompting you to specify a
display name for the data source, and the location of the text file. Enter any name you
would like and then press the 'Browse' button. Browse to help/examples/DataSources/
text/ and select StartGuide.txt.
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& Setup Test File...
Mame : |StanGuide

File : |amhelplexamp|eleataSuurcesltemstaneuide_m Browse. .. |

ok | Cancel |

Clicking 'OK' will bring back up the Data Source Manager where you will see a new
node under "TXTFiles" for the text data source that you have just entered.

There is an additional sample text file under help/examples/DataSources/text/ called
Sample.dat. This expanded sample file contains data for each data type. You can use
this file to explore the different chart types and options.

& Data Source Managet : D:Espres... =] [E3

= . REMOVE

Eﬁ Databases &l
...EEI Winodviewy

- woodviewODBC il

WMLFiles

@;T}(Tles — Ll
...... StartGuide]

& CiassFiles 4'

BACK

CANCEL

MEXT

:

4.4  Step 4: Build a query

To create a new query, click to expand the "Woodview" or "WoodviewODBC" node in
the left-hand frame of the Data Source Manager. Two sub-nodes will appear, one
called "Queries" and one called "Data Views". Select the "Queries" node and click
'‘Add'. A dialog will appear prompting you to specify a name for the query, and to
select whether to launch the Query Builder, or enter an SQL statement.

£ cetupsnL...

ﬁ' Open query builder
('" Enter SL statement

[o]'8 I Cancel |

Enter any name you would like, select 'Open query builder', and click on 'Ok'. The
Query Builder will then launch. You will see a separate window containing all of the
tables for Woodview sitting over top of the main Query Builder window.
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& query1 =] E3
File Edt Wiew Query Help

Design Yiew | SQL view | Datasheet view |

& Database Tables =] —

Tables | views | Queries |

fcategaries
[Customers
[Employees
[Order Details
rders
Products
Add | Close _’Ll
R e =
| | | | | |
Table : -
Feld | | | | | j
Sort : | | |
Aggregation :
Show : | _';I
1 v

From the "Tables" tab add the Categories, Products, Customers, Order Details, and
Orders tables to the query by selecting each, and clicking the 'Add' button. As the
tables are added they will appear in the top half of the query builder window. The
tables will be auto-joined as indicated by the black lines connecting them. Once you
have added the tables, click the 'Close’ button on the tables window.

e Queryt SI=] E3
File Edt View Query Help
Design Yiew | 5oL view | Datasheet view |
¢ Products 5 Order Details | @ orders & Customers | —
= g =l F 3 =l F =
Categaryin Productio || |orderiD CrdeniD ustomerID
|CategoryMame ProductMame 1 Product1D [CustomerID ontactNane =
C stegoryDeseription Description Stain EmployeslD ‘ompany
[CategoryD StainColor [OrderDate ddress
UritFrice: StainCost shipate ity
Stainprice Craantity ShipTe e
Unikstnstock = | [shipaddress x| P =l
« | o |
Table : | | -
Foeld : | I I
Sort
Agaregation : | [ I I I
Show : =
4 I [

To add fields to the query you can either double-click the field from within the table
window, or you can double-click on the "Table" and "Field" fields in the lower-half or
QBE (query by example) portions to make selections from a drop-down menu. Using
either method, add the following fields to the query: CategoryName from the

Categories table, Region from the Customers table, and Quantity from the Orders
table.

Once you have added the fields, double-click in the "Aggregation" field under the
CategoryName column. Select "Group by" as the aggregation type. When you click
elsewhere in the QBE frame all the other columns will default to "Group by" as the

aggregation. Double-click the "Aggregation" field under the Quantity column, and
change the aggregation to "Sum".
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& queryt =] S |
Fie Edt Wiew Query Helbp

.mmlmvmlmtﬁawl

=4 Categories £ Products £ Drder Details | & Orders 2 Customers j

g = [ =
Product1D OrderID [DrderID
Producthlame _L ProductID [CustomerID
Description Stain Employeell
CategorylD StainColor [OrderDate
LiriFrice: StainCost [ShipCrate
StairPrice = Quantity [shipTo
Uricsinstock = | [shipaddress |

g | =

CategoryName | Region |_Sum OF Quantiy | |

Table : Categories Customers Crder Details -
Field | [Categoryllame _ Regin [Quantity [ | | :l
Sort ;| | 1
Aggregation | (Group By Group By Sum | | I
Show | true Thrue brue [ | | -
“ v

Once you have entered the fields, you can preview the results of the query by clicking
on the "Datasheet View" tab. The query will run, and you will see the total sales
volume broken down by product category and sales region.

& uery1 =1 |
Fle Edt Wiew Query Help
Design View | SOL view Dakashest View |

Categonylame | Region | Sum of Quantiy |
Arm Charrs [East KERE | =
Jarm Chairs Midweest. B81.0
At Chairs [South 1850
Arm Chairs st 74.0
Double Dressers  [East les.0
Double Dressers  [Midwest 1z.0
[Double Oressers __[south 7.0
[Oval Tables East 79.0
(el Tables [Midwest 330
(Ol Tables [South 2.0
(Crval Tables et 16,0
[Rectangulsr Tables [Eact B85.0
[Rectangulsr Tables |idwest: 82.0
[Rectangular Tables [South 7.0
[Rectanguler Tables |west sz.0
Fround Tatles [East [143.0
[Round Tables [Pidwest 109.0
Found Tables South 72.0
Found Tatles st .0
Side Chairs [150.8 =l

ﬁ|«|5|»|!1]@l’jl

Once you have finished building the query, select 'Done' from the File menu. The
Query Builder will close, and the Data Source Manager will come back up. There is
now a node under "Queries" for the newly created query.
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& Data Source Manager : D:\Espres... !li[

$ Databases EDIT
Eﬁ Woochiew
[ =s Glueries
L B ..III..]
[ Diata Yiew

(= B ywioodviewoDBC

’El XMLFiles

Bl 1yTFiles REMOVE
- StartGuide

B ClassFiles BACK

= Eigs
CANCEL

MEXT

el

4.5 Step 5: Build a chart

To build a chart, you must first select the data source that you would like to use.
Select either the query that you created or the StartGuide text file, and click the 'Next
button. A new window will open showing the first twenty records of data.

& Chart wizard [x]
Query Result
TNDEX CategoryName |  Regon | Sum Of Quankity |
TYPE Varchar |__Warchar | Double
1 e Chairs East 4.0
2 jrm Chairs Midwest Bl.o
3 i Chairs South 1850
4 b Chairs [west .74.0
s ouble Dressers  Eask |68.0
6 ouble Dressers  Midwest fizo
7 ouble Dressers  South E7o
8 al Tables [East: 7.0
9 Orval Tables Mickuest B3.0
1 (Oval Tables South ps.0
1 {val Tables wrest 160
1 vectangular Tables East B5.0
1 Frectangular Tables Micwest Bzo
14 Flectangular Tables South E70
15 Rectangular Tables fwest Ezo
16 Found Tables East lre30
17 ound Tables Iidveest 1050
18 ound Tables South Fz.o
19 ound Tables west .‘15.0
20 Side: Chairs East l1s0.0
[~ Transpose Data [ Show All Records < Back Concel | mewt>> |
¢ showing the first 20 of 31 records

From this dialog click 'Next' again. A dialog will appear asking you to process data, or

get another data source. Select 'Process Data' and click 'Next'.

& Chart Wizard
E-Merge Data From Other Source

¥ Process Data

(" Get Other Data Source

<< Back I Cancel I Mext == I

The next screen in the chart wizard allows you to select the chart type that you would
like to use. You can toggle between two-dimensional and three-dimensional chart
types using the radio buttons. Select a two-dimensional column chart as the type that
you would like to use and click 'Next'.
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& Chart Wizard [=]
Sample Dimension
; =|||r >
'L Jl M ']. C @
e O
| =]
<cBack | Cancel | mest>>

The next screen allows you to set data mapping for the chart. Data mapping is the
process by which the columns of data from your data source are mapped to the
elements of the chart. By default the first column from left to right (CategoryName) will
be mapped as the data series, the second (Region) column as the categories, and the
third (Quantity) column as Value. To modify the mapping click on the 'Change
Mapping' button.

Dita Mageing

Detaseries: [Catogontiame
Cosgery G ifRegion
v (V):  [Sum of Guantty
7 advee: [rone
mdsedes: [Nene

Combo Linz

g
sEEmEEE
CFEEFEERE

B i Somh W =

ly WL e |
< Bak, Cancel I Dona

This will bring up a new window allowing you to modify the mapping options. From the
drop-down lists, select Region as the data series, and CategoryName as the
categories. Leave the Value option the same.
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& Data Mapping
;--Data Mapping————— 1

DakaSeries : lm
Category (%) :|CategoryMame | ¥
:'v'alue () lm
2nd value ; lm
:2nd Sefies : m
Combo m

Apply

Once you have made the required changes, click on 'Apply' and the chart will be re-
drawn in the mapping window to reflect the changes. Once you have finished setting
the mapping options, click 'Done' and you will go to the Chart Designer window where
you can customize the chart.

4.6 Step 6: Customize chart properties

The default canvas size for charts is 600 x 500 pixels. To adjust the size of the chart
canvas, select 'Canvas' from the Format menu. This will bring up a dialog allowing you
to resize the chart canvas in either pixels, inches, or centimeters.

[Canvas Size 1
| siidch 450

Height : 3&0
F Pixel " Inch " em

rDisplay Seroll Bar——————————
5' s heeded

(" Blways

|~ Never

QK | Cancel :l

Change the canvas dimensions to 450 x 350 pixels, and click 'Ok'. The canvas will
now resize in designer presenting a smaller chart image.
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Fle Insertt Format Type Dril-Down Data Layout Help

E RO TEE PP ST
[ T r—— Color

EEEREEERE T—
I O
i 23 3?g

; ngle U._

size: 450x350Pel

Now that the chart canvas has been shrunk the chart plot will appear small, and
portions of the X-Axis labels may be truncated. This can be adjusted by re-sizing the
chart. You can click and drag on the chart plot to move it, and right-click and drag to
re-size it. You can also click and drag to move the legend. Use these options to
position the chart plot and legend on the canvas.

& chort Designer

Fie Insest Format Type Dril-Down Data Layout Help

Ol 8]s) Ble(b|E]uw] == Al Blo]m] |

Flain &
sie l_mg
| e 0

size: 450x350Pel

Next you can modify the format of the axis labels. To do this click the Axis Elements

e 2
button on the toolbar. #la This will bring up a tabbed dialog allowing you to set
different options for each chart axis. Click on the "Y Axis" tab to bring up options for
the value axis.
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g- Axis Elements...

Kaxis ¥ axis
Axis elements

Grid thickness | 1 i Gridl step interval -
Label step irtervat -

[¥ Showlabelz ¥ Showticker [ Drawficker inward [~ Show grid

[ showaxis [ Label outside plot ares

Sargle

" Locale-specific fxed point

% Fixed poirt

" Sciertific Format... |
-1,000 000,000
o4 I Cancel |

Check the box marked "Show grid" to add grid lines to the Y-Axis. Then select "Fixed
point" for the data format, and click the 'Format' button. This will bring up an additional

dialog allowing you to set format options for the numeric data. Select the number of
decimals as 2 and click 'OK'.

CIFixed Point...
[Fartst
Decimals: IZ_ Units syrbal: M
Rounding: |1_ Units symmbol position: m
Drecimal poirt symiol: E Mengative sigh position: IE
Thousands separatar: Iﬁ é
v Leading zero for fractions
Ok | Cancel |

Click 'OK' again to dismiss the axis elements dialog and you will see the specified
changes reflected in the chart.

450.00
260.00
o Eact
240.00 ® Dlidwest
: B Soath
W Fest
120.00
U-UU'LY—Y—Y—V—V—V—Y$
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To modify the colors of the chart elements, you can click on the 'Randomize Color'
button. This will cycle through various color combinations for the data elements. You
can also change the color for any element by clicking to select it (the hint at the lower
left-hand corner of the design window will indicate the currently selected element) and
picking a new color from the color panel.

Next, you can add titles to the chart. To do this, select Titles' from the Insert menu.
This will bring up a dialog allowing you to enter titles for the chart, as well as each of

the axes.
£ chart Titles

Title:

Chart : [Start Guide - Sales Chart

W-axis IProductCategor‘sr

f-axis ISaIes Waolume

‘ariables. .. | Ok | Cancel |

Enter any titles that you would like for the various elements and click 'OK'. The titles
will then be added to the chart. Titles are placed automatically, but you can manually
adjust their positions, by clicking and dragging the text on the chart canvas.

& Chart Designer =[=1 E3 .
(Fe_Inset Format Type DrilDown Data Layout Help
S T = EA SIS PN A= ST
Color
Start Guide - Sales Chart
420,00 1
i
360,00
g "
=e. o Msdrert
n o fouth
% o Wt
| - |
. . w4 Randomize Colors
.2 8§ 1 % 43 é 58 Font |
F % E £ E 3 E -E IDIaIDr.I 'I
. g E ° ? E [Bola -]
e [ 124
Product Category angle ’—U:;
H9¥ Current sedaction : X axis tite size: 450350Pixel

Finally, you can customize the appearance of the plot area, by adding a background
and border to the plot. To do this, select 'Plot Area' from the Format menu. This will
bring up a dialog allowing you to set display options for the chart plot.
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Draw
area [ Border [ Thickness I 1 il
Appearance

" Raise (" Shadow

Depth |_1i|
Ok | Cancel |

Select to draw both the plot area and the border with a thickness of 1. Specify "None"
for the appearance. Once you have specified the options, click 'OK' and the plot area
for the chart will be modified. You can change the background color of the plot area,
by clicking to select it, and then modifying the color in the color panel.

Start Guide - Sales Chart

" Lower €% Mone

420.00

360.00

o East
B Mficherest
o foath
o Wast

240,00

Sales Yolume

120.00

Ao Chirs =T
Side Chairs —
Single Dressers 4
Triple Dressers ===

Chral Tahles =

Eomd Tables —

Dronible Dressers —-

Rectangular Tahles —|

Product Category

4.7 Step 7: Save and export the chart

Once you have finished customizing the chart, you can save the chart definition by
selecting 'Save As' from the file menu. This will bring up a dialog prompting you to
specify the file name, as well as several other save options.

& Save As..

S [stanGuide

Save As Type [CHT - Chan Format =]
I~ Creste HTMLFle I~ CrestestFile  Browse.. | ok | cancel |

Select to save the chart in CHT format, and specify a file name for the chart. This will
save the chart with its data in the root directory. You can specify a different location if
you like.

Once you have saved the chart, you can export it by clicking the Export button on the

toolbar. @This will bring up a dialog prompting you to specify export options for the
chart.
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Name [StartGuide
save as Type [JPG- JPEG =
vidth [450 height [350 Pixel
I~ 52t Backaround Transparent [~ Generate Data Map Fils
Erowse... | 0K | Cancel |

Specify a name for the generated image file, and select JPEG as the export format.
Click 'OK' and you will be prompted to specify the image quality for the generated
image.

£ 1PEG Quality [ ]

Set JPEG Quality

Specify the maximum quality and click 'OK". A JPEG file will be written in the root

directory of the installation. You can preview the image by opening the generated file
in your Web browser.

& E-\ Inetpub’ wewroot ExpressChart|StartGuide. jpg

| Blo gdt wew Favotes Dok el | |

€. 2.0 B 4 9 @ 3 L Jd

Sop  Refresh  Home Search  Favorites  History P

| address [ B E:instpublwwanoot|EspressChart StartGuide.fpg =l e |
=l
Start Guide - Sales Chart
a0
o Ewn
o Mutrest
1 Lo,
o W
- IH 1.
§ § 2 3 Z § § 8
PR A A
RN R RN
Product Category
} _ =l
#] Done 2 My Computer &

Now you've covered some of the basic functionality of the Chart Designer. Please see
the User's Guide for more detail on any of the features discussed in this guide.
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